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Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the “Terms and Conditions”).

Please read the terms and conditions carefully.

Terms and Conditions

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local government protection agency for both private use and
commercial job sites.
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Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved.
Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access
to, any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such
information for the care and operation of the receiver. The information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and money, and are the result of original selection, coordination
and arrangement by TPS.
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Trademarks

HiPer SR™, TRU™, Magnet™, Pocket-3D™, Topcon® and Topcon Positioning Systems™ are trademarks or registered trademarks
of TPS. Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned by
Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other product and
company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND
THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
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INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR
ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.
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License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) in connection
with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer the Software
or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the
license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the
Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the receiver. All ownership,
copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary
information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the receiver.
Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to
disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other
appropriate remedy.
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Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by
an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license, warranty
and limitation of liability).
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Safety

Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers. Users should review and heed the safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and
Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to
conflict of laws.
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Manual Conventions Y
0]
—rn
This manual uses the following conventions: %
Convention Description Example ()
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest, and click Enter.
Italic Reference to another manual or help document Refer to the Topcon Reference Manual.

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system performance, data
integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of warranty, or
personal injury.

QO G
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Introduction

Topcon’s HiPer SR receiver is a compact, lightweight, and completely integrated GNSS receiver for static and cable-free stop-and-
go/kinematic applications. The integrated receiver design includes a GNSS receiver board based on Vanguard™ technology,
industry leading Fence Antenna™, internal long-life batteries, memory storage, and topcon’s innovative LongLINK™ wireless
communication technology. The HiPer SR delivers world-class positioning and navigation capability to your application by tracking
signals from multi-constellation satellite systems, including GPS, GLONASS, and SBAS.

Topcon’s exclusive LongLINK communication technology provides the perfect small job site system suitable for short range (up to
300m from the Base station) RTK communication. You can also use the HiPer SR receiver as a Network RTK Rover by adding network
option authorization to the receiver and cellular-enabled controller.

The HiPer SR offers complete IP67 protection against dust and water ingress, in addition to superior vibration and shock resistance.
The Topcon communication interface allows you to quickly integrate Topcon’s premium GNSS performance within new systems
and quickly deliver world-class positioning and navigation support to your applications.
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Figure 1: HiPer SR Receiver

HiPer SR Features

The HiPer SR receiver’s advanced design eliminates the need for cables during operation, allowing for a simplified setup and less
parts to keep track of. The HiPer SR receiver features the following:

® Compact, lightweight, and rugged design

® Industry-leading Fence Antenna™ technology

® A premier multi-constellation Vanguard™ technology GNSS board

HiPer SR Features P/N: 1000737-01 2




® |Integrated multi-channel LongLINK™ wireless communication technology

® 2 GBinternal memory

* Internal batteries, providing at least 15 hours of operation in any configuration
* A highly visible display panel with single-button operation

* USB and power/RS-232 ports

The HiPer SR can be configured in a variety of ways, depending on your project requirements. Typically, the HiPer SR supports
the following operation modes:
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® Static post-processing

® LongLINK Base and Rover RTK
® Network Rover RTK

® SBAS-enabled navigation

Unpacking Your Receiver Kit

This section describes the documentation, standard kit components, and accessories (depending on your purchase) that
accompany your receiver. When you unpack your receiver kit, verify you received the items listed in this section. Make sure the
items do not appear damaged from shipment. If any of the items are missing or damaged, contact your Topcon dealer or Topcon
technical support. See “Obtaining Customer Support” on page 7.

® Standard components are illustrated in Figure 2.

® Receiver accessories are illustrated in Figure 3.

® Receiver documentation is listed on page 5.

Unpacking Your Receiver Kit P/N: 1000737-01 3




System Components

The items illustrated in Figure 2 are included with your receiver.
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Power Cable USBE Cable Power Charger Cable Power Supply HiPer SR Reciever
gy — —
L
HiPer SR Manual CD GPS+Software CD Carrying Case LED Display Card ‘Warranty Card

Figure 2: Standard System Components

~ The GPS+ Software CD includes USB drivers, which you need to install to use the USB port for
= communications.
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Accessories

Topcon offers a wide variety of accessories (see Figure 3) specially designed to improve system flexibility and job site efficiency.
For more details on the optional accessories available for HiPer SR, contact your Topcon dealer.

Precisi
Universal Tribrach Trhsrx?h M;Jter Prism Spacer Measuring Tape
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Range Pole

Figure 3: Receiver Accessories

Technical Documents

The HiPer SR Manual CD includes two manuals (listed below) that help you set up and use your new receiver quickly and
efficiently.
® HiPer SR Operator’s Manual — An on-screen help document that contains detailed information on how to use your new
receiver.

® Topcon Receiver Utility (TRU) Reference Guide — An on-screen help document that contains detailed information on how
to use the TRU software included on the GPS+ Software CD. For more information about the TRU software, see “Using
Topcon Software With Your Receiver”.

Technical Documents P/N: 1000737-01 5




Using Topcon Software With Your Receiver

Use the HiPer SR receiver in conjunction with the Topcon Receiver Utility (TRU) and MAGNET Field™ or Pocket-3D applications
for a cable-free positioning solution. Topcon software enables you to configure the receiver and other external devices, manage
files, collect data, and perform survey and construction work flows.
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The Topcon Receiver Utility (TRU) is a hardware configuration software for receivers and peripheral devices. You can install it on
desktop computers and data controllers. This program is provided on the GPS+ Software CD that accompanied your receiver. A
TRU help document is provided on the HiPer SR CD.

Topcon’s MAGNET Field™ software for data controllers provides real-time communication, cloud storage, data collection and
exchange, and field solutions, such as topo, staking, roads, calculations, and more. Contact your Topcon dealer for more
information about MAGNET Field and the entire MAGNET Enterprise system.

Pocket-3D is a program that runs on data controllers with Windows CE® and mobile platforms. Pocket-3D simplifies data
collection, allowing you to check cuts and fills, layout points and survey all or part of the job site quickly and efficiently. Contact
your Topcon dealer for more information about Pocket-3D.

Using Topcon Software With Your Receiver P/N: 1000737-01 6




Getting Technical Support

Before contacting a Topcon customer representative about any problems with the receiver, see “Troubleshooting” on page 47
for some solutions that may fix the issue.

Contact your local Topcon dealer or visit the Topcon Total Care Web site (www.TopconTotalCare.com) for technical support.
///QS For quick and effective support, provide a detailed description of the problem.

When contacting Topcon for technical assistance, provide the following information for better and faster service:

1. Adescription of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in TRU, select Save to
File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory and
storage capacity, etc.

Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Getting Technical Support P/N: 1000737-01
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Website

The Topcon website provides current information about Topcon’s line of products. The support area of the website provides
access to Topcon field and office software, manuals, frequently asked questions, and so forth. To access the Topcon website,

visit www.topconpositioning.com.
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The Topcon’s TotalCare web site also provides complete support, such as news, updates, reminders, training, live Webinars, and
customer service to help you get the information you need. Visit www.topcontotalcare.com.
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Getting Acquainted

The HiPer SR receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, batteries, memory storage, and
wireless communication device.

Receiver Overview

The upper portion of the receiver contains GNSS and LongLINK antennas enclosed by the radome, which is securely surrounded
by a shock-absorbing rubber bumper.

An easy-to-operate display panel, mounting socket, and labels with receiver information are located on the bottom of the
receiver’s magnesium alloy lower enclosure.

The HiPer SR receiver has a highly-visible display panel with single-button operation. The display panel enables you to view the
receiver’s operational status. For more information, see “Display Panel Operations” on page 14.

The mounting socket (Figure 4) connects the receiver to either a standard 58" thread pole or adapter.

You can locate regulatory and product identification information on the two receiver labels. The product identification label
contains the serial number and part number along with a quick response (QR) matrix code. You can scan the QR code with any QR
code application on a smart phone and it will open the product information page at the Topcon Total Care website
(www.topcontotalcare.com).

Getting Acquainted P/N: 1000737-01 9



LED Display Panel

Product ID Label with

0
®
~*
o,
3
09
>
0
e
=
=,
=
—*
®
a%

Part Number and QR Code
Serial Number
Mounting
Socket
Rubber
Bumper

Ports Panel

Figure 4: Bottom Enclosure Overview
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Cables

gently remove the cable.

0

M

=
The HiPer SR package includes a power supply cable, a USB cable, and a power adapter. Table 1 describes the cables included 5
with your receiver. 0Q
1

Align the keyways when connecting the power/serial cable to the receiver port. Turn the cable lock clockwise Na)

////QS until it clicks to secure the cable in place. To disconnect the cable, turn the lock counter-clockwise, and then 5
-

~+

()

a

Table 1. Receiver Cables

Cable Description Cable lllustration

Receiver Power Cable

Connects the receiver to the power adapter through the
SAE connector.

p/n: 1000181-01

USB Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n 14-008081-01

Cables P/N: 1000737-01 11




Cables

Table 1. Receiver Cables

Cable Description

Cable lllustration

Power Adapter

Charges the receiver when connected to a grounded
outlet and the power charger cable.

p/n 22-034101-01

Power Charger Cable
Connects the power adapter to a grounded outlet. Sever-

al options are available for the power charger cable based
on your country. If the kit does not include a power
charger cable, contact your Topcon dealer. Refer to the
these part numbers for available power charger cables:

p/n 14-008052-01 (USA connector)
p/n 14-008054-01 (EUR connector)
p/n 14-008074-01 (AUS connector)
p/n 1000475-01 (BRL connector)

Power and Serial Cable

Connects the receiver to the power adapter through the
SAE connector and an external device through the RS-232
port (DB9 connector). Typically, this cable is not shipped
with the standard kit configuration but is available to
purchase separately.

p/n: 1000182-01

P/N: 1000737-01
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Memory

The HiPer SR is equipped with an internal, non-removable memory card that provides up to 2 GB of data storage. As data is
logged to the receiver’s memory, the REC LED displays the memory capacity status. See “Recording LED” on page 17 for more
information. To access the raw data files in the receiver’s internal memory, see “Managing Files” on page 45.

Internal Batteries

The HiPer SR receiver was designed with two internal, non-removable batteries, so there is no battery door or connectors to

worry about. The batteries are easily charged using the supplied power adapter or an external power source. See “Internal
Batteries” on page 21 for more information.
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LongLINK Wireless Communication

The HiPer SR receiver has integrated LongLINK™ wireless technology that enables multiple (up to 3) cable-free connections to
other HiPer SR devices for LongLINK Base/Rover RTK systems. You can also connect the receiver to other Class 1- and Class 2-

enabled Bluetooth devices (such as data collectors and computers) using Bluetooth wireless technology concurrently with
LongLINK connections.

Topcon's LongLINK technology enables communication of RTCM3 differential corrections between two HiPer SR receivers over

Bluetooth (up to 300 meters), eliminating the need for additional external radios for corrections. For more information, see
“Field System Setup” on page 37.

Memory P/N: 1000737-01 13




Display Panel Operations

The LED display panel (Figure 5) enables you to control receiver power and data recording. The LEDs display the status of the
satellite tracking, recording/memory capacity, Bluetooth and LongLINK connections, and batteries. This chapter describes the
different LED blink patterns and what they mean.

Power Recording Battery
(PWR) (REC) (BATT)

@$®?®

Status Bluetooth
(STAT) (BT)

Figure 5: LED Display Panel
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Power Button

The power button performs multiple functions. The number of seconds in which the button is pressed and held determines how
the receiver will perform. Table 2 describes how to use the power button.

Table 2. Power Button Functions

FUNCTION PRESS BUTTON LED DESCRIPTION
Power On 1+ seconds Power LED blinks green until the startup is complete, and then the LED
turns off.
Power Off 3-10 seconds All LEDs are off. Release the Power button when the Battery LED is solid

red.

Factory Reset
Clear NVRAM

10-15 seconds

All LEDs are off. Release the Power button when the Status LED is solid
red.

Erase All Files

15-20 seconds

All LEDs are off. Release the Power button when the Recording LED is
solid red.

Note: This action is irreversible. If you are unsure about this action,
continue to hold down the button until all LEDs return to normal.

Disregard

More than 20 seconds

All LEDs return to normal, and the receiver has not taken any action.

Open/Close data file

3 times in a row within
2 seconds

Refer to the Recording LED description.

Power Button

P/N: 1000737-01
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Receiver Status LEDs

There are four status LEDs to provide you information about the battery life, tracked satellites, memory capacity, and Bluetooth
wireless connectivity. This section describes the color and behavior of each LED.

Tracking Status LED

The tracking status LED displays how many satellites the receiver is tracking.
Table 3. Status LED Patterns
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LED Color Description
1 P ) One blink per tracked GPS satellite.
2 o> One blink per tracked GLONASS satellite.
3 o> One blink when there are no tracked
satellites or solutions. It is Off otherwise.
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Recording LED

The memory LED indicates if data is being written to memory and displays how much memory the receiver has available for
recording.

Table 4. Recording LED Patterns

Function Description

File logging is in progress. Each blink
indicates data is being written to
memory.

The file is closed. A solid light indicates
no data is being recorded.
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Alternating green and red LEDs indicate
Erasing memory all files are being deleted.

Alternating red and yellow LEDs indicate
Formatting memory | the memory card is being initialized or
formatted.

Missing or faulty The LED is off.
memory

0100001000000
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Bluetooth LED

The Bluetooth LED displays the status of the Bluetooth activity. Table 5 describes the activity.

Table 5. Bluetooth LED Patterns

LED Color Description

Bluetooth is on and waiting for a connection.

A single Bluetooth connection is established.

Multiple LongLINK connections are established. The LED
blinks for each connection every five seconds.

Bluetooth is turned off.

0000

Receiver Status LEDs

P/N: 1000737-01
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Battery LED

The Battery LED indicates the remaining charge of the internal batteries. When an external power source is utilized, the LED
turns green and begins to blink if the batteries begin to charge. See Table 6 for more information.

Table 6. Battery LED Patterns
LED Color ‘ Description

THE RECEIVER IS ON; INTERNAL BATTERIES IN USE
The charge is greater than 50 percent.

The charge is greater than 15 percent.

The charge is less than 15 percent.
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THE RECEIVER IS ON; EXTERNAL POWER IN USE; PWR LED IS SOLID GREEN

An external power source is in use, and the internal batteries are fully charged.

The internal batteries are at greater than 50% capacity; the batteries are being charged.

The internal batteries are at greater than 15% capacity; the batteries are being charged.

The internal batteries are at less than 15% capacity; the batteries are being charged.

THE RECEIVER IS OFF

The receiver is connected to an external power source, and the batteries are fully charged.

00] [9]0/0/0 (000

The receiver is connected to an external power source, and the batteries are being charged.
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Managing Power

This chapter describes how to power the receiver, charge the internal batteries, and use an external power source.
Turning On/Off the Receiver

To turn on the receiver, press and hold the power button until the LEDs briefly flash. When the receiver is turned on, the receiver’s
channels initialize and begin tracking all visible satellites at any time and location.

To turn off the receiver, press and hold the power button for more than three and less than 10 seconds (release the power button
when the BATT LED blinks solid red). This delay prevents the receiver from being turned off by mistake.

The receiver will draw a small amount of power from the batteries when it is turned off. If the receiver is
<//\/>@ placed in storage for a long period, such as a few months, the batteries may become fully discharged. You will
need to use an external power supply or recharge the batteries before use.

Using Internal and External Power Sources

The receiver is powered by the internal batteries or an external power source connected to the power/serial port. If an external
power source is connected, the receiver draws power from it over the battery.

Managing Power P/N: 1000737-01 20



You can connect the receiver to an external power source, such as a vehicle battery, with 6.5 to 30 VDC to operate the receiver.
See “Specifications” on page 57 for more information on external power source requirements to power the receiver and charge
the internal batteries.

Power input greater than 30 VDC could damage the receiver.
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Internal Batteries

The receiver first draws power from a connected external power source. When there is no valid external power source
connected or if the source has discharged lower than 6.5V, the receiver will draw its power from two high-capacity
internal batteries (non-removable). Depending on the use case, the hours of operation provided by the internal batteries
vary, as shown in Table 7.

~ The batteries are shipped from the factory with a partial charge. For maximum operating time, fully charge the
= batteries before using the receiver.
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Table 7. Operation Hours

Approx.
Use Description Hours of
Operation?
LongLINK RTK Base | Base sending RTCM3 differential corrections to one Rover. 15
LongLINK RTK or Rover receiving RTCM3 differential corrections over 17
Network RTK rover LongLINK or from a Network site and connected through
Bluetooth to a data collector.
Static Survey Static setup logging raw GNSS data at 1 Hz. 20

a. When operated at 20° C.

Charging the Batteries

When the battery charge is low, the BAT LED changes from solid green to yellow and then red, depending on the remaining
charge (see “Battery LED” on page 19). When the receiver is connected to an external power source, the batteries begin to
charge whether the receiver is turned on or off.

To charge the batteries:

1. Connect the supplied power cable to the receiver’s power/communication port.
2. Connect the power cable SAE connector to the SAE connector of the power adapter.
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3. Plug the power adapter into an available outlet for approximately five hours to fully charge the batteries. (You
cannot over charge the batteries; the batteries stop charging when they are full.)
The BAT LED blinks as the batteries charge.
~ Use a grounded wall outlet or grounded surge protector while charging. The socket should be located near the
= equipment and easily accessible.

Insufficient Power

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut down and
automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for the battery charge status. See
“Battery LED” on page 19 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become de-activated.
To restore power to your receiver and turn it back on, do one or all of the following:

® Recharge the batteries.
* Make sure the power/serial cable is correctly connected to the receiver’s port.
a. Align the keyways when connecting the power/serial cable to the receiver port.

b. Turn the cable lock clockwise until it clicks to secure the cable in place.

c. Todisconnect the cable, turn the lock counter-clockwise, and then gently remove the cable.
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® Connect the receiver to a different power source.

Power supplied to the receiver should match the specifications provided by Topcon on the product. Failure to
= comply with these specifications may damage the receiver.
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Configuring the Receiver

The sections in this chapter describe receiver options, and how to load a new Option Authorization File (OAF), update firmware,
and perform a factory reset. To do this, you will need to use the Topcon Receiver Utility (TRU) software that was supplied on the
HiPer SR CD. For information about installing the software, see the Topcon Receiver Utility (TRU) Reference Manual.

Viewing Receiver Information

In the Topcon Receiver Utility (TRU), the Receiver Info window displays basic receiver information, such as hardware and firmware
versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

Connect the receiver to a computer and open TRU.

In TRU, connect to the receiver.

Click Device » Application Mode » Receiver Managing.

Click Device » Connect.

In the Connection Parameters window, select the correct serial port, and click Connect.

A e

In the TRU main window, click the Information icon. The Receiver Info window (Figure 6) appears.
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Figure 6: TRU - Receiver Info
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains the following
two files:

® ramimage.ldr — the Receiver board RAM file
® main.ldp — the Receiver board Flash file

To upload firmware files to the receiver:

1. Connect the receiver to a computer using the Power and Serial cable receiver accessory (p/n: 100182-01).

Only use the Power and Serial cable to upload firmware to the receiver. Using a USB or Bluetooth connection
to upload firmware could damage the receiver. The next firmware release, 4.0 SR, will support USB or
Bluetooth connections for firmware uploads. See www.topcontotalcare.com for firmware updates.

2. To connect to the receiver in TRU:
a. Click Device » Application Mode » Receiver Managing.
b. Click Device » Connect.

c. Inthe Connection Parameters window (Figure 7), select Serial Port and the port name, and then click
Connect.
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Figure 7: Connection Parameters Window

3. Click the Firmware % icon in the TRU main window. The Upload Firmware window (Figure 8) displays. This
window enables you to upload firmware files to the connected receiver.

Make sure Receiver is selected in the Device field.

(Recommended) Select Soft Break as the Capture Method.

Browse for and select the receiver board’s RAM and Flash files (Figure 8).

o v s
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Figure 8: Upload Firmware Window

7. Click Start to upload the selected files.
8. Click OK to continue uploading new firmware to the receiver (see Figure 9).
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Figure 9: Finishing Firmware Upload
About the OAF

Topcon issues an Option Authorization File (OAF) to enable the specific options that you purchased. Topcon’s OAF system allows
you to customize and configure the receiver according to your particular needs, therefore purchasing only the options you
require.

The HiPer SR receiver typically ships with an OAF as per initial purchase of the receiver kit configuration. There are several
upgrade options available with the receiver that can extend the receiver’s functionality to better suit your job requirement.
Examples of upgrade options are listed below:
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® GPS + GLONASS dual frequency static operation
® LongLINK base and rover RTK operation
* Network RTK operation
® RTKand update rate at 20 Hz
Contact your Topcon dealer or a representative for a complete listing of available options and pricing information.

Checking the Receiver’'s OAF

To use TRU to view the status of the receiver’s options:

1. Connect the receiver to a computer and open TRU. See the Topcon Receiver Utility (TRU) Reference Manual for
more information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.

3. Click the Options =l icon in the main window. The Receiver Options window (Figure 10) displays, so you can view

ptre

the current authorization options and upload new ones.
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Receiver Options

=E——

Option Name
GPS
Glonass
L1

L2
Cinderella

Position Update Rate, Hz
Raw Data Update Rate, Hz
Code Differential Base
Code Differential Rover
RTK Base

RTK Rover, Hz

Memory, MB

Co-op Tracking

1-PPS Timing Signal

Event Markers

In-Band Int. Rejection
Multipath Reduction

Refresh |

Current Purchased
Yes Yes

Yes Yes

Yes Yes

Yes Mo

Yes Yes

100 20

100 20

Yes Mo

Yes Mo

Yes Mo

100 Disabled
Mot supported 0

Yes Mo
Double Double
Double Mo

Mot supported Disabled
Yes

Leased
Yes
Yes
Yes
Yes
Yes
100
100
Yes
Yes
Yes
100
1,024
Yes
Double
Double
Enabled Outside USA

hi Yes
Upload OAF |

Exp. Date
9/24/2011
9/24/2011
9f24/2011
12f31/2011
9/24/2011
12/31/2011
12f31/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011

~

Save to File

Loading an OAF

Figure 10: Receiver Options

Topcon dealers provide customers with OAF files. For any OAF related questions, e-mail Topcon at options@topcon.com and

include the receiver’s ID and serial number. To obtain these numbers, see “Viewing Receiver Information” on page 25.

To load a new OAF:

1.
2.

About the OAF

Follow the steps in “Checking the Receiver’s OAF” on page 31.
Click Upload OAF on the bottom of the Receiver Options window (see Figure 10).

P/N: 1000737-01
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3. Navigate to the location of the new Option Authorization File (Figure 11).
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Figure 11: Load OAF

4. Select the appropriate file, and click Open (Figure 11).
Topcon’s TRU initially checks to see if the selected file is compatible with the currently connected receiver. If you

chose afile not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver ID and
disables the Upload the File to the Receiver button.
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Figure 12: OAF Compatibility Check

5. Press Upload the File to the Receiver (Figure 12) to start loading the file.
If an OAF file is uploaded to the receiver, TRU will offer to reset the receiver to put new authorization options into
operation (Figure 13).

TR ==

@ The changes will take effect after reset. Reset the receiver?

Figure 13: Reset the Receiver

6. Click Yes.
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Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as ephemeris data
and receiver position. The NVRAM also keeps the current receiver’s settings, such as active antenna input, elevation masks and
recording interval, and information about the receiver’s internal file system. Clearing the receiver’s NVRAM restores the
receiver’s factory default settings.

Although clearing the NVRAM is not recommended as a common practice, there are times when it can eliminate communication
or tracking problems.

After clearing the NVRAM, the receiver requires time to collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps information
about the receiver file system.

You can also use TRU to clear the NVRAM:

1. Connect the receiver to a computer, and open TRU. See the Topcon Receiver Utility (TRU) Reference Manual for
more information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.
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3. Click the Tools icon @ in the main window.

The Tools window appears, enabling you to reset the receiver and clear the NVRAM.
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Figure 14: Tools Dialog Box
4. Click Clear NVRAM, and click Yes to continue.
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Field System Setup

The HiPer SR receiver’s advanced design eliminates the need for cables and antennas during operation, allowing for a simplified
setup and less parts to keep track of.

You can transmit RTK corrections from the Base to the Rover receiver wirelessly up to 300 meters using LongLINK™ wireless
technology. At the same time, you can connect over Bluetooth to a controller running TRU, MAGNET Field™, or Pocket-3D to
configure the instrument, and collect and manage data.

This chapter describes the field setup of your new receiver, so it is ready for use as a LongLINK Base, network, RTK or LongLINK
Rover, or for static data collection.

@ Receiver

Prism Spacer

Tribrach
Adapter Range
Pole
Tribrach
Tripod i

Figure 15: Equipment and Setup

Field System Setup P/N: 1000737-01 37



Setting Up the Base Receiver

Mount the receiver on a tripod with a tribrach, tribrach adapter, and prism spacer, as shown in Figure 16.

Position the base system (from step 1) over a known point.
Level the tripod and measure the height of the receiver from the ground using the tape measure. See “Measuring
Antenna Height” on page 42.

4. Press the power button to turn on the receiver. The integrated wireless device in the receiver turns on when the
receiver is powered.

5. Connect the receiver to the Bluetooth-enabled data collector, running Topcon Field software, to configure and start
the base HiPer SR receiver.

6. View the LED display panel for the receiver’s current status. See also “Display Panel Operations” on page 14.

I
o
a
")
<
0
-+
o
=
)
o
[
=
T

Setting Up the Base Receiver P/N: 1000737-01 38




Receiver

Prism Spacer

Tribrach
Adapter

I
o
a
")
<
0
-+
o
=
»
o
[
=
T

Tribrach

Tripod

Figure 16: Base Receiver
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Setting Up the Rover Receiver

Mount the receiver on the rover pole, as shown in Figure 17.
Attach a Topcon controller to the pole using a mounting bracket.
If you are not using a fixed height rover pole, measure the height of the receiver from the ground. See “Measuring
Antenna Height” on page 42.

4. Press the power button to turn on the receiver. The integrated wireless device in the receiver turns on when the
receiver is powered.

5. Connect the receiver to the Bluetooth-enabled data collector, running Topcon Field software, to configure the HiPer
SR as a rover receiver.

6. View the LED display panel for the receiver’s current status. See also “Display Panel Operations” on page 14.
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Figure 17: RTK Rover
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the station marker,
specify the following:

® Measured height of the antenna above the station marker

* Method of measuring the antenna height

* Model of the antenna/receiver used
Any necessary antenna phase center adjustments, based on the antenna model, is automatically applied. This adjustment, when
combined with accurately measured height and measurement methods, allows for correctly computed reference marker

coordinates.
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To accurately measure the antenna height:

1. Measure the antenna height above the control point or marker, either the slant height or the vertical height.
You may either measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of the
receiver at the base of the mounting threads, or measure the slant height to the Slant Height Measurement Mark
(SHMM) on the side of the receiver. For ARP and SHMM marks on the receiver, see Figure 18.

2. Record the antenna height, points name, and start time in the field notes.
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Figure 18: Antenna Height Measurement Points
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Collecting Data

This chapter provides general information about recording data, downloading it, and removing files to free up internal memory.
Setting Recording Parameters

The Topcon Receiver Utility (TRU) software enables you to set logging parameters, such as logging rate and types of messages, in
which to record data. This software and the TRU Reference Manual is supplied on the HiPer SR CD. See the TRU Reference Manual
for more information. The HiPer SR is compatible with any Topcon field software for configuration and recording raw data.

Logging Rates

The receiver provides up to 2 GB of file space on the internal (non-removable) memory card. The amount of memory used to log
data depends on the logging rate. For more information about setting logging rate parameters, see the TRU Reference Manual.

Recording Data

You can log raw GNSS data to the receiver’s internal memory and use the Topcon Receiver Utility (TRU) or MAGNET Office™
software to download the files to a computer.

To start or stop recording data to the receiver, you can use the LED display panel or TRU.

1. Press the Power button to turn on the receiver.
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2. Wait for the STAT LED to indicate satellites are being tracked. The STAT LED blinks green for GPS satellites and amber
for GLONASS satellites. A short red blink indicates the receiver has not solved a position. Five or more satellites
provide optimal positioning.

3. Pressthe POWER button three times to begin recording. You can also select File Explorer » Logs » Start in TRU to
begin recording data.

4. Make sure the REC light is blinking green. This indicates that a file has opened and data collection has started. The
REC LED blinks each time data is saved to the internal memory.

5.  When you have finished recording, press the POWER button three times, and make sure the REC LED is dark. You
can also select File Explorer » Logs » Stop in TRU to end data recording.

6. To turn off the receiver, press and hold the POWER button for 3 to 10 seconds until all LEDs turn dark and the BAT
LED is solid red.

@@ You can also log data using MAGNET Field software.
=

Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the receiver’s internal
memory, and automatically given a name and a *.tps file extension. A file of collected data can then be transferred to a
computer with file managing software, such as the Topcon Receiver Utility (TRU), which is supplied on the GPS+ CD. These
programs allow you to use an automatic naming feature, enter file names, and delete files as necessary. For more information,
see the TRU Reference Manual supplied on the HiPer SR CD.
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Downloading and Deleting Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or backup. The
receiver’s internal memory holds a finite amount of files, so you will want to delete files to increase memory capacity.

When the internal memory is full, the receiver stops logging data, and the REC LED turns dark/off, indicating an error condition.
Existing data is not overwritten.

There are two options for deleting raw data files from the receiver:
® Delete all of the files using the LED display panel (i.e. hold the power button for 15 to 20 seconds). This erases all of the
files in the receivers internal memory.

® Use a USB, serial, or Bluetooth connection to download the files to a computer. In TRU, you can select the files you want
to delete from the receiver. See the TRU Reference Manual for more information.
Once a connection is established, you can download all or some files to a computer or controller and then use the File Explorer
feature in Topcon Receiver Utility (TRU) to manage the raw data files. For more information about using TRU to download or
delete files, see the Topcon Receiver Utility (TRU) Reference Manual included on the HiPer SR CD.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the hardware.

Check This First!

Before contacting your local dealer or Topcon Technical Support, check the following:

Check all external receiver connections carefully to ensure correct and secure connections. Double check for worn or
defective cables.

Check the receiver’s internal batteries for a full charge.

Check the power source for incorrectly connected cables, and ensure the power source is valid. See “Specifications” on
page 57 for external power requirements.

Check the software. Make sure the most current software version is downloaded onto the computer and the most current
firmware is loaded into the receiver. Check the Topcon website for the latest updates.

Check Topcon Technical Support (www.topconsupport.com) or Topcon Total Care (www.topcontotalcare.com) for the
latest updates.

Then, try the following:

Troubleshooting

Power on and off the receiver by pressing the Power button or by using TRU (Tools » Reset receiver).
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® Restore default settings by pressing the Power button for 10 to 15 seconds or using TRU (Tools » Clear NVRAM). This
restores the receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This
action does not delete data files from the receiver memory.

® Erase all files by pressing the Power button for 15 to 20 seconds or by using File Explorer » Delete All Files in TRU. This
will delete all files stored in the receiver’s non-removable memory card.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
® The battery may be discharged.
— Charge the battery overnight. See “Charging the Batteries” on page 22.
* If you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.
* The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power up,
contact your local dealer or Topcon Technical Support for advice.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller

Cable specific problems:

® The cable is not properly plugged in.
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— Unplug the cable, then securely and properly reconnect it to the receiver.
® The cable is damaged.

— Use an undamaged cable. Contact a dealer to replace the cable.
® The USB driver is not installed.

— If you are using a USB cable connection, make sure the USB driver, included on the GPS+ Software CD, is
installed on the computer. You can also download the driver from the Topcon support Website at
www.topcontotalcare.com.

Generic problems:

* The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. Click Receiver Settings » Ports.

c. Change the Input Mode for the port used for connection to cmd.

Receiver Problems P/N: 1000737-01 49




The receiver does not lock on to satellites for a long period of time

* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track satellites).

— Order a new OAF with the desired options activated to enable or extend validity of the corresponding receiver
options. Contact a dealer or visit the Topcon website for details

— Refer to the “Receiver Managing” chapter of the Topcon Receiver Utility (TRU) Reference Manual for a detailed
description of options.

The receiver tracks too few satellites
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® The survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).

b. InTRU, connect to the receiver.

c. Onthe TRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A code
multipath reduction check box is selected.

® Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK solutions
® Incorrect Base coordinates entered.

— Specify the correct coordinates for the Base station using
TRU or another suitable field data collection software.

® There could be some obstruction to the LongLINK connection.
— Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to the Rover.
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® The corresponding receiver options may be disabled or expired.

— Order a new OAF with the required options activated to enable or extend validity of the corresponding receiver
options.

~ The HiPer SR receiver requires different OAFs for LongLINK, network, and Network and LongLINK operations.
= Contact a Topcon dealer for details about available options to purchase with the receiver.
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— Refer to the Topcon Receiver Utility (TRU) Reference Manual for a detailed description of options.

® There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track at least
five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on the TRU
main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
® Adiscrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:
a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).
b. InTRU, connect to the receiver.
On the TRU main window, choose Receiver Settings » Ports.

d. Double-click on the port to be configured and make sure the input mode of the Rover matches the format
of the Base output mode (i.e. RTCM3).

® Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).
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— Ensure the elevation mask is less than 15 degrees.
* The elevation mask is above 15 degrees.
— Lower the elevation mask. To do this, on the TRU main window, choose Receiver Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
* There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).

The receiver does not start logging data

® The receiver’s memory is disabled or expired.

— Make sure the memory option is enabled. For details, see the Topcon Receiver Utility (TRU) Reference Manual.

® The receiver’s internal memory card does not have free space.
— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files” on
page 46.

LongLINK Problems

The following are some of the most commonly encountered problems.

LongLINK cannot discover the Base receiver

® The Base is out of range.
— Make sure the Base receiver is within 300 meters of the Rover.
® The Base is not responding.

LongLINK Problems P/N: 1000737-01
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— Make sure the Base is turned on.
® Make sure Bluetooth is turned on for the Base and Rover (i.e. the Bluetooth LEDs are blue on both receivers).
* Make sure there are no obstructions or interference.

A Bluetooth connection cannot be established

® A LongLINK connection is not available at the Base. (i.e. 3 connections are already established.)
® Make sure there are no obstructions or interference.

Bluetooth Problems
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The following are some of the most commonly encountered error messages and other problems.

TRU error message: Can’t find receiver

® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
® Thereis interference.
— Move the receiver, controller, or computer to an unobstructed location.
® The receiver is too far away.
— Move the devices closer together.
® The receiver is already connected via Bluetooth to another device.
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— Disconnect the receiver from the other controller or computer.
@@ LongLINK connections will not interfere with Bluetooth connections to computers or controllers.

® The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Reference Manual).
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b. Click Configuration » Receiver » Ports.

c. Change the Input Mode for the Bluetooth serial port used for connection to cmd.

~ /gs This is the most common cause for this error message. Use TRU to double check the settings for the
= connection port.

TRU error message: Open COM# port failed: Access is denied

® Another application uses the computer port dedicated for connection.
— Close the application, then re-connect.
— Connect the receiver via another, unused computer port.
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After searching for available devices, none are discovered

® The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.
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Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it

® Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
® Bluetooth module settings may have changed.

a. If the settings are changed for the Bluetooth module, remove it from the list of discovered Bluetooth
devices using the Bluetooth manager program (supplied with the device used to manage the receiver).

b. Repeat the search.
TRU Problems

The following is the most commonly encountered TRU problem.

TRU cannot connect to the receiver
® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® If using a cable, the cable’s connectors are improperly attached.

TRU Problems P/N: 1000737-01 55




— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
* |If using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.
* |f using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.

— Make sure the computer and receiver use the correct ports for communication. For the HiPer SR receiver, this is
Bluetooth serial port A (btsp\a).

Cleaning and Storing the Receiver

® Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
* Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support

If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Topcon Customer Support.
For contact information, see “Getting Technical Support” on page 7.
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Specifications

The HiPer SR is a Vanguard technology-based GNSS receiver featuring 226 channels and LongLINK wireless technology for small job
site operations and cable-free network solutions. This chapter provides specifications for the receiver and its internal components.

General Details

Table 8 lists the receiver’s general specifications.

Table 8. General Receiver Specifications

Physical
Enclosure Magnesium alloy with Lexan radome
Color Topcon Yellow and Gray (bumper)
Dimensions (mm) 150 (w) x 150 (d) x 64 (h)
Weight (g) 850
Antenna Topcon Fence Antenna™ Technology
Integrated GGD antenna w/ internal ground plane
Status MINTER (4 LEDs + 1 power button)
display/panel
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Table 8. General Receiver Specifications wn

0O

Serial/External Hirose H205-Series (6-pin, multiplex) 2

Power -
Q)

UsB USB Mini B 2.0 (client) EJ'_

External antenna None g

connector 0

Bluetooth antenna Fully integrated, high-sensitivity

Tracking

Number of 226 channels Vanguard™ ASIC with patented Universal

Channels Tracking Channel Technology®

Tracked Signals? GPS: L1 C/A, L1, L2P(Y), L2, L2C code and carrier

GLONASS: L1 C/A, L1P, L2 C/A, L2P code and carrier

SBAS WAAS/EGNOS/MSAS/QZSS) L1 code and carrier

Multipath Yes, code and carrier

reduction

PLL/DLL setting Adjustable bandwidth and order

Smoothing interval Adjustable, code and carrier

Data Output

RTK Corrections TPS, RTCM SC104 v 2.x, 3.x; CMR/CMR+¢
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Table 8. General Receiver Specifications

ASCII Output NMEA 0183 version 2.x and 3.x
RTK position data 20 Hz

rate (max.)

Measurement data | 20 Hz9

rate (max.)

Data and Memory

Removable media None

Internal memory 2 GB

Message storage 20 Hz

rate (max.)

Environment

Operating -20°C to +65°C (batteries)
temperature -40°C to +65°C (w/ external power)
Storage -40°Cto +70°C

temperature

Humidity 100%, condensing

Waterproof rating

IPX7 (1 meter submersion)

Dust rating

IP6X (Fully dust proof)

General Details
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Table 8. General Receiver Specifications

Random vibration MIL-STD 202G, Method 214A, Test Curve A, 5.35g RMS

Sinusoidal vibration | SAE J1211:1978 Section 4.7, 4g Peak
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Shock IEC 60068-2-27 edition 4, Table A.2
25g, 6ms

Topple 2.0m pole drop

Technology

Topcon Vanguard™ ASIC technology

Fence Antenna™ Technology

Topcon advanced Multipath Rejection (AMR)
Integrity Monitoring (RAIM)

Topcon Automatic File Rotation Mode (AFRM)
Universal Tracking Channels

Power

Internal Batteries 7.4V, 5000 mAh

Battery charging <5 hours
time
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Table 8. General Receiver Specifications

Battery charging Connect the AC adaptor to charge the internal batteries.
method Available run charge when connected to an external
battery. Charging of internal batteries when power input
is greater than 12 V.
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Operating time >15 hrs (RTK Rover with LongLINK, internal batteries,
20° Q)

External power 6.5 to 30 VDC®

input

Power 2.0 W (RTK Rover with LongLINK, using internal batteries

consumption at 20° C)

External power Input: 100-240 VAC, 50-60 Hz, 0.8A

supply adapter Output: +12VDC/2.5A

rating

Communication

Serial 1 port; Hirose H205-Series (6-pin, multiplex); RS232
RX/TX
usB 1 port; USB Mini B 2.0 (client)

LongLINK™ wireless | 3 simultaneous connections

Bluetooth v2.1 + EDR

Cellular Yes. Via external Bluetooth-enabled controller or device.
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Table 8. General Receiver Specifications

Survey Accuracy'

Static, fast-static L1 only:
(post-processed) H: 3 mm + 0.8 ppm (x baseline distance)
V:4 mm + 1 ppm (x baseline distance)
L1 +L2:

H: 3 mm + 0.5 ppm (x baseline distance)
V: 5 mm + 0.5 ppm (x baseline distance)

Kinematic, RTK L1 +L2:
H: 10 mm + 1 ppm
V: 15 mm + 1 ppm

DGPS H:0.4m
V:0.6m
SBAS H:1.0m
V:15m
Cold start <40 sec.
Warm start <20 sec.

Reacquisition
<1 sec.

RTK Time-to-First- <20 sec.
Fix (TTFF)

General Details P/N: 1000737-01
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. Vanguard ASIC includes two dedicated channels for L-Band signal tracking. The

HiPer SR receiver does not support L-Band signal tracking.

The HiPer SR includes the latest Vanguard ASIC technology, and is capable of

supporting planned signals for both Galileo and COMPASS. Support will be
incorporated to HiPer SR when these constellations have matured and are ready
for commercial use.

CMR/CMR+ is a third-party proprietary format. Use of this format is not
recommended and performance cannot be guaranteed. Use of industry standard
RTCM 3.x is always recommended for optimal performance.

100 Hz operation can be supported for custom applications. For more
information, contact your dealer.

. 6.5 to 30 VDC is the operating range of the external power source when the
receiver is on. To turn the receiver on, the power input must be between 8 to 30
VDC. To charge the internal batteries, the external power input must be greater
than 12 VDC.

Accuracy will vary depending on the number of satellites used, obstructions,
satellite geometry (PDOP), occupation time, multipath effects, and atmospheric
conditions. Performance may be degraded in conditions with high lonospheric
activity, extreme multipath, or under dense foliage. For maximum system
accuracy, always follow best practices for GNSS data collections.
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Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 25cm between the user and the receiver when
operating LongLINK technology.

TPS receivers are designed for survey and survey related uses (that is, surveying coordinates, distances, angles and
depths, and recording such measurements). This product should never be used:
* Without the user thoroughly understanding this manual.

* After disabling safety systems or altering the product.
® With unauthorized accessories.

* Without proper safeguards at the survey site.

® Contrary to applicable laws, rules, and regulations.
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Receiver Warnings

Tampering with the receiver by the end users or non-factory authorized technicians will void the receiver’s

warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or otherwise
treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

Only allow authorized Topcon warranty service centers to service or repair this product.

Receiver Warnings P/N: 1000737-01
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The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the FCC radio
frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of RF energy that it deemed to
comply without maximum permissive exposure evaluation (MPE). But it is desirable that it should be installed and operated with
at least 20cm and more between the radiator and person’s body (excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part 15 of the FCC rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.
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® Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the
following two conditions: (1) this device may not cause interference, and (2) this device must accept any
interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de
licence. L’exploitation est autorisée aux deux conditions suivantes : (1) [’appareil ne doit pas produire de
brouillage, et (2) lutilisateur de ’appareil doit accepter tout brouilage radioélectrique subi, méme si le
brouillage est susceptible d’en compromettre le fonctionnement.

Industry Canada Compliance P/N: 1000737-01
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European Community.

European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

* EN301489-1V1.8.1(2008-04)
* EN301489-17 V2.1.1 (2009-05)
* EN300328V1.7.1(2006-10)
* EN60950-1: 2006 + A11:2009/A1:2010
* EN301489-3V1.4.1(2002-08)
* EN300440-2V1.4.1
The following CE mark is affixed to the device:

C€

This is a Class A product. In a domestic environment this product may cause radio interference in which case
the user may be required to take adequate measures.
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Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky
[Czech]

Dansk
[Danish]

Deutsch
[German]

Eesti
[Estonian]

English

Espafiol
[Spanish]

(Topcon) timto prohlasSuje, Ze tento (HiPer SR) je ve shod se
zakladnimi pozadavky a dalSimi pislusnymi ustanovenimi smrnice
1999/5/ES.

Undertegnede (Topcon) erklaerer herved, at falgende udstyr
(HiPer SR) overholder de veesentlige krav og gvrige relevante krav
i direktiv 1999/5/EF.

Hiermit erklart (Topcon) dass sich das Geréat (HiPer SR) in
Ubereinstimmung mit den grundlegenden Anforderungen und den
Ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Kaesolevaga kinnitab (Topcon) seadme (HiPer SR) vastavust
direktiivi 1999/5/EU pdhinduetele ja nimetatud direktiivist
tulenevatele teistele asjakohastele satetele.

Hereby, (Topcon) declares that this (HiPer SR) is in compliance
with the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Por medio de la presente (Topcon) declara que el (HiPer SR)
cumple con los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1000737-01
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[Greek]

Francais
[French]

Italiano
[ltalian]

Latviski
[Latvian]

Lietuvi
[Lithuanian]

Nederlands
[Dutch]

Malti
[Maltese]

ME THN NAPQYZA (Topcon Positioning Systems,
Inc.) AHAQNEI OTI (GRX1) ZYMMOPOQNETAI
MPOZ TIZ OYZIQAEIZ ANAITHZELIZ KAI TIZ AOIMEZ
ZXETIKEZ AIATA=ZEIZ THZ OAHITAZ 1599/5/EK.

Par la présente (Topcon) déclare que I'appareil (HiPer SR) est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Con la presente (Topcon) dichiara che questo (HiPer SR) é
conforme ai requisiti essenziali ed alle altre disposizioni pertinenti
stabilite dalla direttiva 1999/5/CE.

Ar 30 (Topcon) deklar, ka (HiPer SR) atbilst Direktvas 1999/5/EK
btiskajm prasbm un citiem ar to saisttajiem noteikumiem.

Siuo (Topcon) deklaruoja, kad Sis (HiPer SR) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Hierbij verklaart (Topcon) dat het toestel (HiPer SR) in
overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Hawnhekk, (Topcon) , jiddikjara li dan (HiPer SR) jikkonforma
mal-tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm
fid-Dirrettiva 1999/5/EC.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1000737-01
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Magyar
[Hungarian]

Polski
[Polish]

Portugués
[Portugues]

Slovensko
[Slovenian]

Slovensy
[Slovak]

Suomi
[Finnish]

Svenska
[Swedish]

Alulirott, (Topcon) nyilatkozom, hogy a (HiPer SR) megfelel a
vonatkoz6 alapvetd kovetelményeknek és az 1999/5/EC iranyelv
egyéb eldirasainak.

Niniejszym, (Topcon) , deklaruj, e (HiPer SR) spenia wymagania
zasadnicze oraz stosowne postanowienia zawarte Dyrektywie
1999/5/EC.

(Topcon) declara que este (HiPer SR) esta conforme com os
requisitos essenciais e outras disposi¢des da Directiva 1999/5/CE.

(Topcon) izjavlja, da je ta (HiPer SR) v skladu z bistvenimi
zahtevami in ostalimi relevantnimi doloili direktive 1999/5/ES.

(Topcon) tymto vyhlasuje, ze (HiPer SR) spa zakladné
poziadavky a vSetky prislusné ustanovenia Smernice 1999/5/ES.

(Topcon) vakuuttaa taten ettd (HiPer SR) tyyppinen laite on
direktiivin 1999/5/EY oleellisten vaatimusten ja sita koskevien
direktiivin muiden ehtojen mukainen.

Harmed intygar (Topcon) att denna (HiPer SR) star |
Overensstammelse med de véasentliga egenskapskrav och 6vriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1000737-01
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#¢ TOPCON

Declaration of Conformity
With regard to the R&TTE Directive 1999/5/EC

Topcon P

y Inc. EC Canformity for the f ing product:

Product Identification

Brand: Tapcon
Model Type: HiPeR SR
Model Number: 1000036-01
Description: GNSS Receiver
Manufacturer
Mame: Taopcon Positioning Systems, Inc.
Address: 7400 National Drive, Livermore, CA 34550
Country:
Tel: +1025-245-8300 Fax: +1925-245-8581

Means of Conformity
The product was tested and found in conformity with the foll

ETSI EN 301 488-17 v2.1.1 (2009-05) ETSI EN 301 489-1v1.8.1 (2008-04)
ETSI EN 300 440-2  v1.4.1 (2010-08) ETSI EN 301 489-3 v1.4.1 (2002-08)
ETSIEN300328  v1.7.1 (2006-10) CENELEC EN 60950-1:2006:/A41:2010

All essential radio test suites have been carried out.

Fraser Smith ya na

Director, Product Management, GNSS Managing Dirsctor

Topcen Positioning Systems, Inc. Topcon Europe Pesitioning B.V.
July 17, 2012 July 17, 2012

EU Representative

Name: Topcon Eurcpe Positioning BV,

Address:  Essebaan 11, 2908 LJ Capelle afd ljssel
Country.  The Netherlands

Tel +31-10-4585077  Fax:  +31-10-4585045

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1000737-01
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WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring this product is
disposed of correctly, to help prevent potential negative consequences for the environment and human health, which could
otherwise be caused by inappropriate waste handling of this product. For more detailed information about the take-back and
recycling of this product, please contact a supplier where you purchased the product or consult.

I
Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

® Baseband

* HCI

® Link Manager

® Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid for any antenna
with the same or less gain.
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Korean KC-RF Compliance
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& AF2E (Wireless specification): Bluetooth 2.1 + EDR
A2 F10}4 (Used Frequency): 2402-2480 MhZ

ME 2= (the number of channels): 79

2388 (Antenna Power): 2.1 dBi

B X 8tAl (Type of the modulation): GFSK, 8PSK

ISHE (Product Id Code): KCC-CRM-T8S-1000036-01

WESDN; (Applicant): Topcon Positioning Systems, Inc.

J1019 3 (Type of equipment): GPS surveying device with Bluetooth radio
24 0|2 (Model Name): HiPeR SR or GSX2

MEAE (Year of manufacture): 2012

MIZEX 2 MZE=IF (Manufacturer and country of origin): PC Partner , China

OISX AY 25 (Applicant Code): T8S
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Glossary

Glossary

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for nearby Rover (mobile)
GNSS receivers.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over short distances from
fixed and mobile devices.

C
COMPASS - BeiDou Navigation Satellite System maintained and operated by China.

G

GALILEO — The satellite system currently being maintained and operated by the European Union (EU) and European Space Agency
(ESA).

GGD — GPS + GLONASS Dual Frequency signal tracking.

GLONASS - The GLObal NAvigation Satellite System maintained and operated by the Russian Federation.
GNSS - Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS - The Global Positioning System maintained and operated by the United States Department of Defense.
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L
L1 —The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.
L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Aiesso|H

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s components and
control receiver operations.

LongLINK™ —Topcon’s LongLINK RTK technology provides short-range RTK communication up to 1,000 ft. (300m from the Base
station).

M
MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of the MAGNET
software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

N

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK corrections to the
Rover.

(0]

Option Authorization File (OAF) — This enables the specific features that a customer purchases.
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P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward, with the phase of
the signal being equal at any point on the sphere.

Pocket-3D - Field controller software by Topcon that supports both GNSS and TS.

R

Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the measurement quality
without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.

Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems. SBAS transmits differential
corrections and messages for navigation satellites that are within sight of a network or reference stations in a wide area, such
as a continent.

Static Survey — Typically uses a network or multiple baseline approach for positioning. This method provides the highest
accuracy and requires the longest observation times.

P/N: 1000737-01 77
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T

Topcon Receiver Utility (TRU) — Hardware configuration software for receivers and peripheral devices. TRU is included on the
GPS+ Software CD that accompanied your receiver.

U

Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller, computer, etc.
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TOPCON

Topcon Positioning Systems, Inc.
7400 National Drive, Livermore, CA 94550
800-443:4567  www.topconpositioning.com

HiPer SR Operator’s Manual
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